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Anaconda Warning

Anaconda Terms of Service (TOS) are changing!

Starting July 15, 2025 companies over 200 employees will need to 
purchase licenses of Anaconda.  Because of this, Wolf Star is moving 

away from Anaconda to Native Python.

Python 13 is required.  Wolf Star will provide the necessary open 
source modules via a script.



Enhancements Overview

• Highlights:

– Equivalent Static Modes

– Speed increase: “Parallel Tensors”

– HyperLife Interface Button

– Gauge Angle Optimization

– Display standard gauges option

• 33 Enhancements, 8 Bug Fixes

• Help Options: Members Area and Documentation



Help Options



Help Options

Register for the Members Area to view video tutorials
at https://www.wolfstartech.com/

https://www.wolfstartech.com/


Help Options

Tools

True-Tools Help

Common Tools

True-QSE

True-LDE

True-Load

TFU Manager

Duty Cycle

Measure Utilities

Python Shell

tfuTools

View the 
documentation 
from the True-
Tools Help form.

True-Tools Help



Details

Bug Fixes

Enhancements - Overview

True-Load Enhancements 2026-03-15



Utilitarian Improvements

Update / Install

Details
Anaconda / Python Installer and GUI-Less Installer Reprise RLM Update

HyperLife Export

FEA Codes
AbaqusFEMAPSimCenter

Standard Gauge DisplayParallel Tensors

Import Gauges from 3 Pt CSV Bulk Stats Channel Filtering

Gauge Angle OptimizationEquivalent Static Modes

Color Bar Height

Get Host ID GOI LabelsHoops Envision

Post-Test Report: Map File NamePattern Gauges: Drag Select

ODS Load Old Limits Post-Test – Drop Gauges



Bug Fixes



Module Type Description

PRE Bug Fix issue of GOI not working once GOIs are deleted

PRE Bug

Fix issue with STL Gauge Box dimensions changing when 

depth is changed

ALL Bug Tag Max / Min label on graphics area prints in a column

POST BUG

TLD names with a space using GOIs would cause an error 

when trying to acces the HTML file names which have no 

space.

QSE Bug GOIs don't load from TLD

QSE Bug FFT Domain Responses not working

PRE Bug Switch to / from VTFx mode not working on some models

PRE Bug Parallel Tensor infinite loop when initializing…

Bugs

Module Type Description



Enhancements - Overview



Enhancements – True-Load Environment

Highlighted Records

Documented on 
Details page

Module Type Description

ALL Enhancement

In update FEA DB Utility also add option for relative / 

absolute path

ALL Enhancement Ensure the Colorbar takes full height / width of window

ALL Enhancement

Create an Error Trap for when the user does not have 

HOMEDRIVE HOMEPATH created correctly and create a 

WST_folder in the Scratch directory -- fixed with more 

robust HomePath routine

ALL Enhancement Fix dock widget size for results mgr

ALL Enhancement Utility to get HostID

ALL Enhancement

Replace all instances of HOMEDIR, HOMEPATH with 

getReliableUserHomeDir()

ALL Enhancement Add Static Equivalent Modes utility GUI

ALL Enhancement Add Static Equivalent Modes utility functionality

ALL Enhancement

Update ABQ Plug In Utilities to work with new python 

issues

ALL Enhancement Change references from Ceetron to Hoops Envision



Enhancements – TFU Mgr

Highlighted Records Documented on Details page

Module Type Description



Enhancements - Pre

Highlighted Records

Documented on 
Details page

Module Type Description

PRE Enhancement Tweak & Swap - Angle Optimization

PRE Enhancement Make Gauge STL pointers be Outies

PRE Enhancement Add option to draw gauges boxes instead of lines

PRE Enhancement Brute-Force parallel tensors

PRE Enhancement Make sure report out folder in the TLD dir

PRE Enhancement

Sort / Re-order needs to turn Lightning bolt on when 

gauges move up / down or sorted.

PRE Enhancement Mirror / Pattern -- Click / Drag to select / deselect

PRE Enhancement Gauge Box to be the default STL style in Write Gauge Lines

PRE Enhancement Link Write Gauge Lines form to the Gauge Label Combo

PRE Enhancement Add ability to use 3PT CSV files for gauge import

PRE Enhancement Add switch to turn parallel gather tensors on / off

PRE Enhancement Print eMat = nicer



Enhancements - Post

Highlighted Records Documented on Details page

Module Type Description

POST Enhancement Add MAP file to header info of Input Files

POST Enhancement show dropped gauges on strain load

Module



Module Type Description

QSE Enhancement HyperLIfe interface button

QSE Enhancement ODS load old time points -- have a cancel button

QSE Enhancement Draw GOIs with gauge labels only

Enhancements - QSE

Highlighted Records Documented on Details page

Module Type Description



Enhancements – 3rd Party

Highlighted Records Documented on Details page

ALL Enhancement

Update ABQ Plug In Utilities to work with new python 

issues

Module Type Description



Anaconda / Python Installer
and GUI-Less Installer



Anaconda Warning

Anaconda Terms of Service (TOS) are changing!

Starting July 15, 2025 companies over 200 employees will need to purchase licenses 
of Anaconda.  Because of this, Wolf Star is moving away from Anaconda to Native 

Python.

Python 13 is required.  Wolf Star will provide the necessary open source modules via 
a script.



FROM 2023-10-22 VERSION DOC …



Installer and GUI-Less Install



Installer GUI Update

New button – Only for Admins

This downloads “installConfig.py” to enable 
GUI-less (command line) install of True-Load

Everything else 
works the same as 

before



GUI-Less (command line) install

1) Get the installConfig.py file

1

You will browse for a folder to 
store this file in.



installConfig.py
# installConfig.py

#

# Configuration file for automating / prepopulating installation parameters

#

# This is python, all paths should be preceded by "r" (r=raw text string)

#==============================================================================

# Python Imports

# -----------------------------------------------------------------------------

import os

from win32com.client import Dispatch

shell = Dispatch('WScript.Shell')

# -----------------------------------------------------------------------------

# Helper variables

# -----------------------------------------------------------------------------

winDeskTop = shell.SpecialFolders("Desktop")      # Path to Windows Desktop

winTemp    = os.environ['TEMP']                   # Path to Windows Temp directory

homeDrive  = os.environ['HOMEDRIVE']              # User Home Drive

homePath   = os.environ['HOMEPATH']               # User Home Directory

homeDir    = os.path.join(homeDrive, homePath)    # User Home Directory (full path)

#==============================================================================

#                               User variables

# -----------------------------------------------------------------------------

unAttendedInstallFlag = True                # --> True = No GUI, False = GUI

destDir               = r'C:\trueLoadApp'   # --> True-Load Application Destination

defFEA                = '*.odb'             # --> Default FEA ['*.odb', '*.rst', '*.op2', '*.h3d', '*.neu']

openAsVTFxFlag        = False               # --> Converts FEA to VTFx; True=On, False=Off

shortCutDir           = winDeskTop          # --> Location for True-Load shortcut

shortCutWorkDir       = winTemp             # --> Working directory for True-Load Shortcut

scratchDir            = 'TEMP'              # --> WST_scratch location ['HOME', 'TEMP', <path>]

licenseVar            = 'WOLFSTAR_LICENSE'  # --> value for WOLFSTAR_LICENSE  *** DO NOT CHANGE ***

licensePath           = '5053@WST11'        # --> Location of license server or file [port@host, <path to LIC file>]

# *** Optionally ***

pythonDir             = None                # --> Location of Python [None, <path>]

postInstallScript     = r"C:\scratch\helloWorld.bat"  # Path to script to be run post install [None, <path>]

Edit the installConfig.py to suite your 
environment.



Unzip the installer

Method 1: 7Zip Method 2: Zip

RMB

1) Rename EXE to ZIP

RMB



Copy installConfig.py to installer folder

Run tlInstaller.bat



Reprise RLM Update



Reprise RLM Update

• True-Load license management 
system is now running on the 
latest version of Reprise RLM 
Software.

• This should eliminate any security 
concerns.

• It will not affect any current 
license installs.



Ansys Plugin



Ansys 2024

Supports Ansys 2024 and 
Earlier versions



Abaqus



Abaqus 2024

Supports Python 3 in Abaqus

Tools→3rd Party Plugins→Install Abaqus 2024+ CAE Plugins
installs the plugins into Abaqus CAE

Includes all of the great Abaqus CAE utilities

True-Load

Additional updates have 
been made to work in the 

Python 3 environment



FEMAP



Install FEMAP Plugin

True-Load FEMAP

Tools→3rd Party Plugins→Install FEMAP Plugin 
installs the plugin into FEMAP



Launch True-Load from FEMAP



SimCenter



Install SimCenter Plugin

Tools→3rd Party Plugins→Install Siemens SimCenter Plugin 
installs the plugin into SimCenter

True-Load SimCenter



Launch True-Load from SimCenter



Import Gauges from 3 Pt CSV



Import Gauges from 3 Pt CSV

Gauges can now be 
imported from a 3 Pt 
formatted CSV file.
Previously, only the Gauge 
Lines CSV format was 
accepted. 

Indicate the format using 
the CSV Type options 
(details next) ->

Load Previously Defined Gauges



Import Gauges from 3 Pt CSV

The 3 Pt option is for a CSV file 
containing three rows of x,y,z data for 
each gauge.  The three x,y,z rows are 
describing three points that lie along 
the gauge.

The Gauge Lines option is for a CSV 
file with x,y,z,u,v,w data on each row 
of the CSV file describing the position 
(x, y, z) and orientation vector (u, v, 
w) of each gauge. This was the 
default in previous releases.

CSV Type



Gauge Angle Optimization



Gauge Angle Optimization

• Find the orientation for the 
selected gauge that 
minimizes the overall 
condition number.

• Choose Quick, Good, or 
Precise (time vs precision)

• Parallel Tensors required 
due to processing speed.

Tweak and SwapPre-Test

Optimize Gauge Angle



HyperLife Export



HyperLife Export

1

2

To export load and 
event functions to 
HyperLife, (1) click 
the HyperLife Export 
button and (2) 
choose your settings.

True-QSE supports Altair HyperLife, a Siemens product. 



HyperLife Export

Load data is saved 
as a CSV file

Event data is saved as an XML file.

The XML file can be directly opened in the HyperLife software.  
Note that fatigue materials will need to be assigned in the HyperLife software.



Standard Gauge Display



Standard Gauge Display

There is now an option to display 
standard strain gauges on the model. 

Accurate gauge shapes assist in 
visualization, planning, and real-world 
gauge placement.



Gauge Shape

Select  nits

Standard Gauge Display

Pre-Test Gauge Label Options

Display standard gauges on the model:

1 2

3 Choose

CEA-125 CEA-250

OR 4



Standard Gauge Display

Labeled with Gauge Number 
and Gauge Name



Standard Gauge Display

Dimension Reference:

• CEA-125: 10.77mm x 6.9mm x 2.14mm, Vishay MicroMeasurements DataSheet

• CEA-250: 14.0mm x 6.9mm x 2.14mm, Vishay MicroMeasurements DataSheet

CEA-125 CEA-250

https://docs.micro-measurements.com/?id=2553&_gl=1*18usnkx*_gcl_au*NDY3MjM4ODg3LjE3Njg5MDY0NTE.*_ga*MTEwOTA2MDE1My4xNzY4OTA2NDUx*_ga_PJJTYL5W9L*czE3Njg5MDY0NTEkbzEkZzEkdDE3Njg5MDY1MDMkajYwJGwwJGgxNTE3MDU0NzQ3
https://docs.micro-measurements.com/?id=2553&_gl=1*18usnkx*_gcl_au*NDY3MjM4ODg3LjE3Njg5MDY0NTE.*_ga*MTEwOTA2MDE1My4xNzY4OTA2NDUx*_ga_PJJTYL5W9L*czE3Njg5MDY0NTEkbzEkZzEkdDE3Njg5MDY1MDMkajYwJGwwJGgxNTE3MDU0NzQ3
https://docs.micro-measurements.com/?id=2553&_gl=1*18usnkx*_gcl_au*NDY3MjM4ODg3LjE3Njg5MDY0NTE.*_ga*MTEwOTA2MDE1My4xNzY4OTA2NDUx*_ga_PJJTYL5W9L*czE3Njg5MDY0NTEkbzEkZzEkdDE3Njg5MDY1MDMkajYwJGwwJGgxNTE3MDU0NzQ3
https://docs.micro-measurements.com/?id=2586&_gl=1*1mywgcs*_gcl_au*NDY3MjM4ODg3LjE3Njg5MDY0NTE.*_ga*MTEwOTA2MDE1My4xNzY4OTA2NDUx*_ga_PJJTYL5W9L*czE3Njg5MDY0NTEkbzEkZzEkdDE3Njg5MDY2MTUkajYwJGwwJGgxNTE3MDU0NzQ3
https://docs.micro-measurements.com/?id=2586&_gl=1*1mywgcs*_gcl_au*NDY3MjM4ODg3LjE3Njg5MDY0NTE.*_ga*MTEwOTA2MDE1My4xNzY4OTA2NDUx*_ga_PJJTYL5W9L*czE3Njg5MDY0NTEkbzEkZzEkdDE3Njg5MDY2MTUkajYwJGwwJGgxNTE3MDU0NzQ3
https://docs.micro-measurements.com/?id=2586&_gl=1*1mywgcs*_gcl_au*NDY3MjM4ODg3LjE3Njg5MDY0NTE.*_ga*MTEwOTA2MDE1My4xNzY4OTA2NDUx*_ga_PJJTYL5W9L*czE3Njg5MDY0NTEkbzEkZzEkdDE3Njg5MDY2MTUkajYwJGwwJGgxNTE3MDU0NzQ3


Standard Gauge Display

Export these gauges with the 
“3D STL” option.

Pre-Test

Make Gauge Lines

3D STLGauge Box



Parallel Tensors



Parallel Tensors

Speed Increase!!!

The newly added optional Parallel Element Tensors feature increases the speed of:

• Finding gauges

• Updating the eMat

• All operations that require gathering element tensors in Pre-Test and Post-Test

Benchmarking shows an average speed increase for gather element tensors operations 
of 1631%! This translates into an average speed increase for Find Gauges of 338%.



Parallel Tensors

Enable Parallel Tensors with the “Parallel” checkbox on the Pre-Test form.

Note – this feature is 
enabled by default 
when creating new 

TLD files.



Parallel Tensors

Enable Parallel Tensors with the “Parallel” checkbox on the Pre-Test form.

One-time operations done automatically 
when the “Parallel” checked:  

1) A VTFx version of the FEA file is generated

2) The element tensors for all shell elements in 
the model for all loads in the load table are stored 

on disk as PKL files.



Bulk Stats Channel Filtering



Bulk Stats Channel Filtering

In addition to the Filter Files 
feature, Bulk Stats now has a 
Filter Channels feature.
• Channel (function) filters are 

case-sensitive and applied 
after clicking “Apply”.

• Channel filters are applied 
whether the section is 
expanded or hidden – only 
clearing the filter fields 
removes channel filters.

Channel 
Filter 
Fields

Clear 
Channel 
Filters

TFU Manager Bulk Stats

1 2 Expand 
Filter Channels

Section

3



Equivalent Static Modes



Equivalent Static Modes

True-Load now supports modal analysis of redesigns with the Equivalent Static Modes utility.

Read a detailed explanation in the documentation: Common Tools > Tools Menu > 6.12 Equivalent 
Static Modes

Equivalent Static Modes is a new method developed by Dr. Tim Hunter and Dr. Sudhir Kaul in 
2025 and currently awaiting peer review. With Equivalent Static Modes:
• Estimate the dynamic response of a system through multiple design iterations using 

previously calculated modal participation factors (MPFs)
• Explore designs directly in True-QSE
• About 10x faster than alternatives (i.e. eigenmode calculation)



Equivalent Static Modes

1. Set up a TLD file based on eigenmodes.

Pre-Test



Equivalent Static Modes

2. Use Post-Test to generate 
QSE file containing the MPFs 
of the modes.

Post-Test

QSE File with MPFs



Equivalent Static Modes

3. Create a new FEA 
model with design 
changes.  

Write the input deck 
for the FEA solver (e.g. 
INP, BDF, DAT, FEM)



Equivalent Static Modes

4. Launch the Equivalent Static 
Modes tool from the Tools 
menu. In the Equivalent Static 
Modes form:

a) Select the TLD file from 
step 1

b) Click the Generate 
Acceleration Fields 
button

c) Select the input deck 
from step 3

d) Click the Generate 
Equivalent Static 
Modes button



Equivalent Static Modes

5. Step 4.d creates a FEA input 
deck ending with “staticModes”.  

Solve this input deck.



Equivalent Static Modes

6. Open the QSE file from step 2.  
It is recommended to perform a 
File Save As (1).  In the True-QSE 
GUI, point the FEA DB to the FEA 
DB (2) generated in Step 5.  
Note, a slight anomaly in the 
True-QSE GUI.  It is best to now 
Close and Save the QSE file (3) 
and then re-open True-QSE (4).  
This process heals the FEA Step 
names to the new quasi-static 
equivalent static mode names.

Once this is done, the QSE file can be used to generate any response on the 
structure, generate durability runs or even create an Operating Deflection Shape.
This is all done WITHOUT additional Eigenmodes or new MPF Calculations!!!!



Color Bar Height



Color Bar Height

Colorbar takes full height regardless of 
screen resolution



Get Host ID



Get Host ID
Tools→Get Host ID

1



GOI Labels



GOI Labels
GOIs in QSE now shown with labels only.

Previously these labels were verbose and 
very large.



Hoops Envision



Hoops Envision

Ceetron is now Hoops Envision

3D visualization within True-Load is powered 
by Hoops Envision from Tech Soft 3D



Post-Test Report: Map File Name



Post-Test Report: Map File Name

Post-Test Report:  Input and Output Files 
Map File (.map)



Pattern Gauges: Drag Select



Pattern Gauges: Drag Select

Drag

Release

Click

Select multiple rows with click-and-drag.

Before the user had to check each gauge 
one by one.



ODS Load Old Limits



ODS Load Old Limits

OK or Wait retrieves 
previous time limits
OK or Wait retrieves 
previous time limits

Cancel sets limits to 
full time domain
Cancel sets limits to 
full time domain



Post-Test – Drop Gauges



Post-Test – Drop Gauges

When loading strain data:
If MAP exists, gauges are automatically 
dropped

When loading strain data:
If MAP file exists, gauges are automatically 
dropped
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